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GETTING STARTED 
 
Please print this Tutorial before beginning.  Using a printed copy will avoid 
confusion between each step by not having to switch screens. 
 
Abstract:  This Tutorial will help the user open TrainingRegister®, navigate, find 
records, prepare a few reports and obtain an overview of what can be done with 
TrainingRegister®. To reduce the size, only the more common reports are used in the 
demonstration. Performance of Administration tasks will be covered in subsequent 
tutorials and in the User Guide. 
 
Opening TrainingRegister® 
 
Double-click the shortcut on the Windows Desktop or go to the Windows Start 
Menu, click on Programs, then click on TrainingRegister.  The icon is a vertical stack 
of books.  Licensing and Copyright information will appear on the initial splash screen.  
Click [OK] to continue. 
 
Demonstration messages disappear when the system is purchased. 
 
Refreshing the Sample Database: 
This step is needed if there is a chance the sample database has been altered by another 
user working through one of the tutorials. 
 
Select [Help], [Refresh Sample Database]  - This replaces the working copy of the 
sample database with a fresh unmodified copy.  The dates and data will then match 
examples in the tutorial. 
 
 
 
 

TrainingRegister® 
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Switching to the Sample Database – Active TrainingRegister® Licensees  
 
Demo Users: Skip this step and go directly to the next section labeled Logging In.  
 
TrainingRegister® Licensees: 
If TrainingRegister® defaults to a company’s master training database, then it can be 
fooled into using the sample database for training, tutorials or experimentation. 
 
Select [Help], [Switch to Sample Database] – Do not exit TrainingRegister®. 
 
When logging back in, the sample database will be used. 
 
When TrainingRegister® is exited, the master database will again be the default database. 
 
Logging In 
 
To login, click the [File] Menu, then [User Login]. 
 
Enter "1234" and "TEMP" for User ID and Password. This will login Jane Doe with 
maximum permissions. Login information is not case sensitive.  
 
When using a company’s master database, enter the User ID and password assigned.   
 
Note: Login can be skipped if TrainingRegister® is configured to recognize network 
logins.  This is true for both the Administration and Web Modules. 
 
TrainingRegister® Reminders 
 
Soon after logging in, a message appears asking the user if they would like to check 
TrainingRegister® Reminders. 
 
Press ENTER or click [Yes] and notice the reminders listed.  Reminders will be covered 
in a subsequent tutoria l and in the User Guide. 
 
Press ENTER or click [OK] to continue. 
 
User Level 
 
Instructional messages are displayed 
throughout TrainingRegister®. Once a user 
becomes confident, raising the User Level can 
turn off some messages. 
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Let’s start by reviewing the more common Tables, the Forms for finding 
and editing data in those Tables and then prepare a few basic reports. 
 
Tables Menu 
 
Click the [Tables] Menu and 
be patient with the mouse 
while we discuss how the more 
common tables are used.  The 
next instruc tion will be on the 
next page when we actually 
open the People Table. 
 
Skipping ahead will cause the user to miss an important understanding of 
TrainingRegister®. 
 
Data entry Forms for each database table are found on the [Tables] Menu.  When a Table 
is selected, a Form is opened that can be used to view, edit, delete or add new records.  
Data entry Forms are usually empty until the [Find] Button is used to select a record for 
editing. The [Find] button is located in the lower left corner of each Form along side 
other navigation buttons. 
 
It is Standard Operating Procedure  to open a Form by selecting the Table name on the 
[Tables] Menu and then use either the [New] button to add a new record, or the [Find] 
button to locate an existing record. Otherwise an Empty Form will be displayed and the 
new user will be wondering why. Once a record is displayed on the Form, reports can be 
prepared and Tasks can be performed.  The number of records found or retrieved will be 
displayed just above the [Find] Button. 
 

 
 
The People Table is a no-brainer.  Any person that needs to be saved in 
TrainingRegister® will go in the People table. This includes all Employees, Students, 
Instructors, Supervisors, Training Administrators, etc. Records in the People table can be 
classified in many different ways.  Many of these classifications are copied to the training 
records for the person. Example: People and their training records can be classified with a 
department classification.  A report that lists people who have completed a class can then 
be limited to people from a specific department. Records in the People table are generally 
not deleted.  Previous employees are marked “inactive”. This process retains the person’s 
training records and keeps them from searches and reports that identify needed training.  
TrainingRegister® provides a utility to update employee data from an HR or payroll 
database. 
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The Companies Table will at minimum contain a record for the licensee’s own 
organization or company.  The licensee’s company can then be selected as a training 
provider when creating a new class.  Individuals in the People Table can be classified 
with a Company from the Companies Table.  The scope for many reports can be limited 
to a specific company.  If employees of multiple companies are trained, the Company 
classification can be used to prepare reports specific to each client company. 
 
The ClassCatalog Table contains permanent information about each class. Generally, a 
learning experience is entered only once in the ClassCatalog Table even though it may be 
taught or scheduled many times. ClassCatalog records are never deleted unless they are 
entered by mistake because they are part of the permanent training records. 
 
The ClassSchedule Table is used to add scheduling information to classes that have 
already been saved in the ClassCatalog Table.  When a schedule class has been 
completed and the enrollment records have been converted to completed training records, 
the ClassSchedule record can be deleted or saved for future reference.  The training 
records will be linked to the original ClassCatalog record. 
 
List Box Tables opens several sub-menus to access a couple dozen different tables that 
are used to fill various drop-down List Boxes. These drop-down list boxes are typically 
used to classify people or training.  Example: The Departments Table is used to classify 
employees in the People Table.  When an employee takes training, their training record 
will be automatically classified with the department used to classify their People record.  
The scope selection for many reports will offer the department classification as one of the 
options.  Each record in the Department Table can be classified with a Supervisor that is 
selected from the People Table.  The people who are classified with the department can 
then be traced to the supervisor of that department. 
 
The Configuration Tables opens a sub-menu to TrainingRegister® settings and 
registration information. 
 
Multiple Forms Open at Same Time: 
Multiple Forms can be open at the same time, just like multiple documents can be open in 
Microsoft Word.  In Word, use the [Windows] Menu to switch between open documents.  
In TrainingRegister®, use the [Windows] Menu to switch between open Forms. 
 
Open forms are disabled (grayed out) on the [Tables] Menu. As long as a Form is open, it 
will be listed on the [Windows] Menu along with any other open Form. 
 
People Table – Navigation and Reports 
 
Click on [Tables] Menu, then select [People]. This opens a data entry Form that can be 
used to add, edit or delete a record. 
 
If this is the first form opened, a Novice level message appears stating how open forms 
can be selected on the [Window] Menu. 
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Click [OK] to continue. 
 
Click the [Tables] Menu again and see that the [People] selection is now disabled (grayed 
out) because it is already open.  Click on the [Window] Menu and see the [People] 
selection is now listed as an open window. 
 

 
 
When first opened, the Form for the People Table will be empty. It will display zero 
records. The user must use either the [New] button to add a new record, the [Find] button 
to locate an existing record or the [Close] button to close the Form. All other buttons are 
either hidden or disabled because they do not apply to the current situation. We will use 
the [Find] button to locate a record for Cindy Adams. 
 
[Find] a Person in the People Table: 
Click the [Find] button located in the bottom left corner of the People Form.  A pop-up 
will display several options for locating a person. Accept the default selection of [Last 
and/or First name] by pressing ENTER or clicking [OK].  Type “Adams” and press 
ENTER or click [GO].  You will see that three matching records were found for the last 
name “Adams”.  Select “Adams, Cindy” from the drop-down list box and press ENTER 
or click [OK] to accept the selection. 
 
Use Speed / Shortcut Keys to Find a Person: 
The exact same task just performed can be performed without the mouse.  Notice the “F” 
in the [Find] button is underlined.  This means the [Find] button can be pressed by 
holding the ALT key while touching the F key.  Buttons that are darkened or have the 
focus can be selected by pressing the ENTER key.  A few of the more common tasks in 
TrainingRegister have designated shortcut keys.  Lets try locating the record for Cindy 
Adams without using the mouse. 
 
Using the keyboard only type or press the following: 
 
ALT-F  - this activates the [Find] key 
 
ENTER – this activates the [OK] button to accept the default search method 
 
Adams  – this enters Cindy’s last name in the text box 
 
ENTER – this activates the [OK] button to accept the last name entry and perform the 
initial search 
 
DOWN ARROW – use the little finger on the right hand to press the down arrow and 
select Cindy Adams from the drop-down list box. 
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ENTER - this activates the [OK] button to accept Cindy Adams as our selection. 
 
Visually confirm that Cindy Adams’ record is displayed on the Form. 
 
CURRENT PERSON Concept: The person 
displayed on the Form for the People Table is 
called the “Current Person”.  Click on the 
[Window] Menu again and note that “Adams, 
Cindy” is now displayed as the current person.  
 
If there is a task or report that is performed for the “Current Person” is will now be 
known that the current person is the person displayed on the Form for the People Table.  
This is true even if other Forms are open and possibly covering the Form displaying the 
“Current Person”. 
 
[Reports] Tab: 
Click on the [Reports] Tab that is located toward the upper right portion of the People 
Form. 
 
The [Reports] Tab is different from the [Reports] Menu located just under the 
TrainingRegister® Title Bar.  The [Reports] Tab has a few common reports that are 
specific for the “Current Person” – Cindy Adams.  
 
The reports listed on the [Reports] Tab can also be found on the [Reports] Menu located 
just under the TrainingRegister® Title Bar. 
 
Prepare Report Showing the Training Schedule for Cindy Adams: 
Click the [Training Schedule] button on the [Reports] Tab.  Press ENTER or click [OK] 
to accept the default choices.  This report will list the classes Cindy Adams is scheduled 
to attend or instruct. 
 
Examine and close the report by closing the browser. 
 
Note: If you happen to double-click the [X] to close the browser, TrainingRegister® 
might also be closed if the two [X] line up on the screen.  Use caution to click the [X] 
only once. 
 
Prepare Report Listing All Training Records for Cindy Adams: 
Click the [Training Records] button on the [Reports] Tab.  Press ENTER or click [OK] to 
accept the default choices.  This report will list of ALL training records for Cindy Adams 
including two classes that have not been completed yet. 
 
See the Phase column on the report.  Training records can be classified as “Enrolled”, 
“Waiting”, “Dropped” or “Completed”.  Until completed, zero hours are recorded. Many 
other data such as CEU, Grade, and Status are saved with each training record and can be 
included on this report.  The report scope can also be limited to a date range. 
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Examine and close the report by closing the browser. 
 
Prepare Report Showing Status of Required/Mandated Training: 
On the same [Reports] Tab click the [Training Program Requirements – with Detail].  
Press ENTER or click [OK] to accept the default choices.   
 
This report details the status of required/mandated training.  The previous report 
[Training Records] showed all training including required training. 
 
Notice on the report that Cindy is linked to three training programs.  Each program has its 
own requirements in the form of required classes. One of the programs contains periodic 
training denoted by the number of months in the Interval column.  If a periodic interval is 
not specified, training is required only once. 
 
Target Dates are available if needed.  They will not be discussed in this tutorial. 
 
PRINT:  Use the browser’s print feature to make a copy of this report.  This will avoid 
replicating this report when we discuss Tracking Required/Mandated Training later in 
this Tutorial. 
 
Close the report. 
 
Prepare a List of Skills for Cindy Adams: 
On the same [Reports] Tab click the [List of Skills] button.  Press ENTER or click [OK] 
to accept the default choices.  
 
The report displays all skills linked to Cindy. Skills are a method of classifying people.  
Skill tracking is independent from training records.  Skills are often used to classify a 
person after they have acquired that skill through a series of training, testing or on-the-job 
experience. 
 
PRINT:  Use the browser’s print feature to make a copy of this report. This will avoid 
replicating this report when we discuss Skill Tracking later in this Tutorial. 
 
Close the report. 
 
Prepare Report Listing All People with a Specific Skill: 
Select the [Reports] Menu located just under the TrainingRegister® Title Bar.  This is 
different from the [Reports] Tab we have been using up to this point. 
 
On the [Reports] Menu, select [Skill Tracking Reports], [People with a Specific Skill]. 
 
From the drop-down list box, select the “TEACHING” skill. 
 
Press ENTER or click [OK] to accept the default choices.  
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This report lists all the people in the database who have been classified with the 
“TEACHING” skill.  The Skill Level, Acquired Date and approving supervisor are all 
optional entries that could be useful.  Skill Levels are defined by the training 
administrator and can be any alphanumeric entry. 
 
PRINT:  Use the browser’s print feature to make a copy of this report. This will avoid 
replicating this report when we discuss Skill Tracking later in this Tutorial. 
 
Close the report. 
 
Do not [Close] the Form for the People Table.  We are about to open a second form and 
want to demonstrate how multiple forms can be open at the same time. 
 
ClassCatalog Table – Navigation and Reports 
 
Click on [Tables] Menu, then select [ClassCatalog]. This opens a data entry Form that 
can be used to add, edit or delete a record. 
 
If this is the first form opened, a Novice level message appears stating how open forms 
can be selected on the [Window] Menu. 
 
Multiple Forms Demonstration: 
Again select the [Tables] Menu and notice that selections for People and ClassCatalog 
are both disabled (grayed out).  This is because they are already open.  
 
Select the [Windows] Menu and notice that both open Forms are listed.  The check mark 
indicates which Form is displayed on-top.  Since we just opened the Form for the 
ClassCatalog Table, it has the check mark. 
 
Click [People….] on the [Windows] Menu.  This places the check mark on the People 
selection and brings the Form for the People Table to the top. 
 
Return the Form for the ClassCatalog Table to the Top: 
Click [ClassCatalog] on the [Window] Menu.  This places the check mark on the 
ClassCatalog selection and brings the Form for the ClassCatalog Table to the top. 
 
[Find] a Class in the ClassCatalog Table: 
Click the [Find] button located in the bottom left corner of the ClassCatalog Form.  A 
pop-up will display several options for locating a class. Accept the default selection of 
[Title/Keyword Name] by pressing ENTER or click [OK]. Type “Payroll” and press 
ENTER or click [GO].  You will see that three matching records were found that contain 
the keyword “Payroll” in the class title. Select “PAYROLL CODING WORKSHOP” 
(class # 99) from the drop-down list box and press ENTER or click [OK] to accept the 
selection. 
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Use Speed / Shortcut Keys to Find a Class: 
The exact same task just performed can be performed without the mouse.  Notice the “F” 
in the [Find] button is underlined.  This means the [Find] button can be pressed by 
holding the ALT key while touching the F key.  Buttons that are darkened or have the 
focus can be selected by pressing the ENTER key.  A few of the more common tasks in 
TrainingRegister® have designated shortcut keys.  Lets try locating the PAYROLL 
CODING WORKSHOP class without using the mouse. 
 
Using the keyboard only type or press the following: 
 
ALT-F  - this activates the [Find] key 
 
ENTER – this activates the [OK] button to accept the default search method 
 
payroll – this enters the search keyword in the text box 
 
ENTER – this activates the [OK] button to accept the search keyword and perform the 
initial search 
 
DOWN ARROW – use the little finger on the right hand to press the down arrow and 
select PAYROLL CODING WORKSHOP from the drop-down list box. 
 
ENTER - this activates the [OK] button to accept PAYROLL CODING WORKSHOP as 
our selection. 
 
Visually confirm that PAYROLL CODING WORKSHOP with ClassID 99 is displayed 
on the Form. 
 
Note:  ClassIDs are user defined and can be any alphanumeric entry up to 15 characters. 
Each record will have a unique ClassID. 
 
CURRENT CLASS Concept: The 
class displayed on the Form for the 
ClassCatalog Table is called the 
“Current Class”.  Click on the 
[Windows] Menu again and notice the 
ClassCatalog selection includes the title of the “Current Class”. 
 
If there is a task or report that is performed for the “Current Class” is will now be known 
that the current class is the class displayed on the Form for the ClassCatalog Table. This 
is true even if other Forms are open and possibly covering the Form displaying the 
“Current Class”. 
 
[Reports] Tab: 
Click on the [Reports] Tab that is located toward the upper right portion of the 
ClassCatalog Form. 
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The [Reports] Tab is different from the [Reports] Menu located just under the 
TrainingRegister® Title Bar.  The [Reports] Tab has a few common reports that are 
specific for the “Current Class” – Payroll Coding Workshop.   
 
The reports listed on the [Reports] Tab can also be found on the [Reports] Menu located 
just under the TrainingRegister® Title Bar. 
 
Prepare Report Listing People Who Have Completed Payroll Coding Workshop: 
Click the [Completed Training/Historical Roster] button on the [Reports] Tab.  Press 
ENTER or click [OK] to accept the default choices. 
 
This report will list of ALL people who completed Payroll Coding Workshop. 
 
Only training records that are classified as “Completed” are listed with this report. Many 
other data such as CEU, Grade, and Status are saved with each training record and can be 
included on this report.  The report scope can also be limited to a specific completion 
date, a date range, people classified with a specific Company, Division, Department, 
Group, etc. 
 
Examine and Close the report by closing the browser. 
 
Note: If you happen to double-click the [X] to close the browser, TrainingRegister® 
might also be closed if the two [X] line up on the screen.  Use caution to click the [X] 
only once. 
 
Prepare Report Listing People Who Need A Class or Training: 
On the same [Reports] tab for Payroll Coding Workshop click on the [People Who Need 
this Class] button.  Press ENTER or click [OK] to accept the default choices. 
 
Displayed will be a list of each person who is required to have this class and has not yet 
received the training. 
 
Many other data could have been added to this report such as the Company, Division, 
Department, or Group for each person.  The TargetDate, Next Due date, and periodic 
interval fields could also have been selected for this report. The scope of the report could 
have been selected for a specific Company, Division, Department, Group, etc.  If periodic 
training were involved a future date could be entered to eliminate people who just 
finished the training and will need it again in another year or two. 
 
Note: The TrainingRegister Messaging Feature  can be used to send each of these 
people an email.  The message could possibly be used to notify them that they need the 
training and the class has been scheduled one or more times. 
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PRINT:  Use the browser’s print feature to make a copy of this report.  This will avoid 
replicating this report when we discuss Tracking Required/Mandated Training later in 
this Tutorial. 
 
Close the report. 
 
Prepare Report Listing People Waiting for Payroll Coding Workshop: 
On the same [Reports] tab for Payroll Coding Workshop click on the [Training Waitlist] 
button.  Press ENTER or click [OK] to accept the default choices. 
 
This report lists the people who are waiting for any schedule instance of this class.  They 
are listed in the order they were placed on the waitlist. 
 
If a person enrolls in any scheduled instance of this class, they will automatically be 
removed from the waitlist. 
 
If a group enrollment is performed and the waitlist is selected as the group, people from 
the waitlist will be enrolled in the order they were placed on the waitlist until the class is 
full. If more seats are added to the schedule class (discussed later in this tutorial) then the 
same waitlist can be selected again for a group enrollment and more will be enrolled. 
 
Examine and close the report. 
 
Do not [Close] the Form for the ClassCatalog Table.  We are about to open a third form 
and will demonstrate how multiple forms can be open at the same time. 
 
 
ClassSchedule Table – Navigation and Reports 
 
Click the [Tables] Menu, then select [ClassSchedule]. This opens a data entry Form that 
can be used to add, edit or delete a record. 
 
If this is the first form opened, a Novice level message appears stating how open forms 
can be selected on the [Window] Menu. 
 
Multiple Forms Demonstration: 
Again select the [Tables] Menu and notice that selections for People, ClassCatalog and 
ClassSchedule are disabled (grayed out).  This is because they are already open.  
 
Select the [Window] Menu and notice that three open Forms are listed.  The check mark 
indicates which Form is on-top.  Since we just opened the Form for the ClassSchedule 
Table, it has the check mark. 
 
Click [People….] on the [Windows] Menu.  This places the check mark on the People 
selection and brings the Form for the People Table to the top.  Cindy Adams should still 
be displayed.  If needed click the [General] Tab on the People Form. 
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Return the Form for the ClassSchedule Table to the Top: 
Click [ClassSchedule] on the [Window] Menu.  This places the check mark on the 
ClassSchedule selection and brings the Form for the ClassSchedule Table to the top. 
 
[Find] a Scheduled Class in the ClassSchedule Table: 
Click the [Find] button located in the bottom left corner of the ClassSchedule Form.  A 
pop-up will display several options for locating a scheduled class. 
 
Accept the default selection of [Select a Specific Scheduled Class Record] by pressing 
ENTER or clicking [OK]. 
 
A search form titled: Find Scheduled Class will be displayed similar to the following: 
 

 
The search for a Scheduled Class is a little more complex than finding a record in the 
People or ClassCatalog tables. The ClassSchedule Table may contain records for future 
classes that will accept enrollments, classes that are complete and need to be posted, 
classes that have been cancelled and classes that have been completed and their 
enrollment records have been posted. In addition a single class title may be scheduled 
multiple times. 
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Leave the “Scope” in section 1 pre-selected to [Future Scheduled Classes]. 
 
Select PAYROLL CODING WORKSHOP (99) in the first drop-down list box. 
 
After selecting a class name in the first drop-down list box, the second drop-down list 
box will be filled with all the scheduled dates for the selected class. 
 
Select 04/06/2006 at 8:00 AM from the second drop-down list box. 
 
Finally, press ENTER or click [OK] to accept your selection and retrieve that record to 
the ClassSchedule Form. 
 
[Reports] Tab: 
Click on the [Reports] Tab that is located toward the upper right portion of the 
ClassSchedule Form. 
 
The [Reports] Tab is different from the [Reports] Menu located just under the 
TrainingRegister® Title Bar.  The [Reports] Tab has a few common reports that are 
specific for the currently selected Scheduled Class.  
 
Prepare Report Showing Enrollment Roster and Sign-in Sheet: 
On the [Reports] tab for the selected scheduled class, click on the [Enrollment Roster] 
button.  Press ENTER or click [OK] to accept the default choices. 
 
The report displays each student enrolled in the selected scheduled class.  Selecting all 
the defaults resulted in a Sign- in Sheet that can be used to verify attendance.  Those not 
in attendance can be dropped from the class before the enrollment records are converted 
to completed training records.  This step will be described in another tutorial. 
 
Note: Scheduling conflicts will be noted on this report with an “X” as noted. 
 
This report could have been limited to a specific group of people such as a company, 
division, department or group. Other fields could have been selected to help identify each 
participant and the sign- in block could have been omitted. 
 
Examine and close the report by closing the browser. 
 
Note: If you happen to double-click the [X] to close the browser, TrainingRegister® 
might also be closed if the two [X] line up on the screen.  Use caution to click the [X] 
only once. 
 
Prepare Duplicate Confirmation Letter: 
On the same [Reports] tab for the selected scheduled class, click on the [Duplicate 
Confirmation Letter] button. 
 
Select Elrod, Doris from the drop-down list box. 
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Click [OK] to accept selected student. 
 
The same report could have been selected from the [Reports] Tab on the People Form.  
The student would be selected first and the class would be selected from the drop-down 
list box. 
 
A Few Words about Enrollments and Confirmation Letters: Enrollments can be 
performed in several different ways and the confirmations vary. 
 
1) Enrollments can be performed by the training administrator using the Administration 
Module. This task can be performed for a single person or for a selected group of people 
such as all people in a department, people with a specific job classification or people who 
need required or mandated training.  The waitlist can also be selected for a group 
enrollment (discussed earlier). 
 
The confirmation letter we just prepared is an exact duplicate of the one created 
automatically when a single person is enrolled using the Administration Module. The 
confirmation can be printed and delivered, or emailed as a page to the student or the 
supervisor.  The line beginning “This letter is to confirm…” (confirmation header) and 
the three lines at the bottom (confirmation footer) can be customized with any amount of 
text. This customization can be on a per class basis otherwise global defaults will be 
used. 
 
The TrainingRegister® Messaging Feature can be used to select all enrollees and send 
them a confirmation, change or other information about the class. 
 
2) Enrollments can also be performed by the student, using the Web Module.  This is a 
companion software package that provides limited access to employees and supervisors.  
 
If students self-enroll using the Web Module, they will receive instant confirmation in 
their browser which eliminates the need for the confirmation letter.  
 
The Web Module can be configured to prevent students from self-enrolling. An 
enrollment request is then sent via email.  The training administrator performs the 
enrollment using the Administration Module after approving the enrollment request. 
 
A combination of methods can be used to enroll students in any class.  Some students 
could self-enroll. A supervisor could enroll some students. A training administrator could 
enroll some students. 
 
The training administrator can always use the messaging system to send the enrollees a 
message.  This is not dependant on the method used to enroll the students. 
 
Supervisors can be given permission to enroll their own staff in training using the Web 
Module. 
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The Web Module can be configured to send Supervisors an email notification when one 
of their staff self-enrolls. 
 
The different methods of performing enrollments will be covered in a subsequent Tutorial 
and in the User’s Guide. 
 
Examine and close the report. 
 
Prepare a Training Calendar: 
In this example the [Reports] Menu located just under the TrainingRegister® Title Bar 
will be used. 
 
Select [Reports], [ClassSchedule Related Reports], [Training Calendar]. 
 
To test the calendar with the sample database, you must select a date range that will 
include data. Otherwise the calendar will be empty.  For this demo we will use April 1, 
2006 for the Start Date. The End Date will default to the last day of the month. 
 
Click the down-arrow button at the end of 
the date field to display a pop-up calendar. 
 
Select April 1, 2006 for the Start Date.   
 
Date Range Selection Note:  When you 
select a Begin Date, the End Date defaults 
to approximately 30 days after the Begin 
Date. The End Date can, of course be 
edited.  If the selected Start Date is the 
first day of a month then the End Date will 
default to the last day of the same month making it easy to select a calendar month.  Any 
date range can be selected using the Select Date Range form. 
 
Press ENTER or click [OK] to accept the date range entered. 
 
Press ENTER or click [OK] as needed to accept the default choices. 
 
A calendar for the month of April 2006 will be displayed in the browser.  The instructor’s 
name is prefixed with an asterisk.  
 
A few other choices were available if we had not accepted the default report choices.  If 
needed, we could have selected a 6 or 7 day calendar.  We could have narrowed the 
report scope to include specific types of classes provided the original ClassCatalog 
records were classified appropriately. 
 
Examine and close the report. 
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Prepare a Master List of Quailfied Instructors with Classes: 
In this example the [Reports] Menu located just under the TrainingRegister® Title Bar 
will be used. 
 
Select [Reports], [ClassCatalog Related Reports], [Master List of Instructors with 
Classes]. 
 
Unlike most reports, there are no extra choices required for this report. 
 
This report lists each Instructor and the classes they are qualified to teach. 
 
General Information about Instructors: 
The first step in creating an instructor is to locate their record in the People table and 
check the [Instructor] check box to classify them as an instructor.  This puts them on a 
master list of instructors. 
 

 
 
The second step is to select the person from the master list of instructors and identify 
them as a qualified instructor for a specific class.  This is done with a button on the 
[Tasks] Tab of the ClassCatalog Form labeled [Designate Qualified Instructor(s)]. 
 
Each time the class is scheduled in the ClassSchedule Table, the qualified instructor can 
be scheduled along with the class.  Only qualified instructors can be scheduled. 
 
Examine and close the report. 
 
 
Tracking Required or Mandated Training 
 
Reports in this section will identify the following: 

• What Training Programs have been defined 
• What Classes are Needed 
• Who Needs Each Class – prepared earlier 
• Progress or Status of an Individual – prepared earlier 

 
TrainingRegister® can track training that is required once in a lifetime or on a periodic 
basis.  Training Programs are analogous to curricula, training paths or tracks.  A Training 
Programs is created or invented for a specific reason, purpose, need or group of people. 
Each “Training Program” is then associated with one or more required classes. Finally, 
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each person required to have the training is linked or associated to the Training Program.  
Since this is all very user-definable, it can be kept simple or made very complex. 
 
Note:  Training requirements can be changed without affecting permanent training 
records.  Completed training records are analyzed and factored into the needed training 
reports.  An employee could be in one training program, change positions and then be 
placed in a new training program or they could be placed in a second training program to 
begin preparing them for a new position or task.  Any training they have taken will 
remain in their permanent training records. 
 
Prepare List of all Training Programs with Associated Classes/Training: 
In this example the [Reports] Menu located just under the TrainingRegister® Title Bar 
will be used. 
 
Click the [Reports] Menu, then select [Required / Needed Training Related Reports], [All 
Required Classes Grouped by Training Program]. 
 
Press ENTER or click [OK] to accept the default choices. 
 
This report displays all training programs designed and entered. A training program in 
TrainingRegister® might also be known as a curricula, path or track.  Each program 
contains one or more required classes and can be designed for any reason desired.  
Training that is required on a periodic basis will have a periodic interval.  If target dates 
have been entered at the class level they will be displayed here. 
 
A class can be a requirement of multiple programs.  A person can be linked to multiple 
programs.  TrainingRegister® is very flexible and permits the user to create simple or 
complex training programs. 
 
Examine and close the report. 
 
Prepare a List of Needed Classes: 
In this example the [Reports] Menu located just under the TrainingRegister® Title Bar 
will be used. 
 
Click the [Reports] Menu, then select [Required / Needed Training Related Reports], 
[Needed Classes – Prioritized List]. 
 
Press ENTER or click [OK] to accept the default choices.  
 
This report lists all needed, required and/or mandated training that is needed by one or 
more individuals.  The number of people who need each class prioritizes these data. This 
information can assist with management decisions to schedule training. 
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Take note of how many people need PAYROLL CODING WORKSHOP (99).  Who are 
these people?  How can we notify them that we have scheduled one or more sessions for 
this training?  These questions will be answered with the next two reports. 
 
Examine and close the report. 
 
Prepare Report Listing People Who Need A Class: 
This report was prepared and printed earlier from the [Reports] Tab for PAYROLL 
CODING WORKSHOP (99), in the section discussing the ClassCatalog Table and 
related reports. 
 
Listed are all the people who need the specific class.  As described earlier, they can be 
sent a message using the TrainingRegister® Messaging Feature. 
 
Prepare Report Showing Progress/Status of Required/Mandated Training for an 
Individual: 
This report was prepared and printed earlier from the [Reports] Tab for Cindy Adams.  If 
needed see the instructions in the section about the People Table and related reports. 
 
Listed are three training programs Cindy is linked to and the training requirements for 
each. The listing for each class shows if it has been completed and when or if it is needed. 
If the training is required on a periodic basis, a periodic interval and next due date are 
shown. 
 
Skill Tracking 
 
People can be classified with one or multiple skills.  In addition, a skill level, date 
acquired, and approving supervisor can be optionally entered when linking or associating 
a person to a skill.  Skills are not linked or associated to training records but could be 
assigned after a person has achieved a skill through training, experience or testing. 
 
Display the Skills for an Individual: 
This report was prepared and printed earlier from the [Reports] Tab for Cindy Adams.  If 
needed see the instructions in the section about the People Table and related reports. 
 
The report lists all skills linked or associated to Cindy Adams. The Skill Level, Acquired 
Date and approving supervisor are all optional entries that could be useful.  Skill Levels 
are defined by the training administrator and can be any alphanumeric entry. 
 
Display all People with a Specific Skill: 
This report was prepared and printed earlier from the [Reports] Menu.  If needed see the 
instructions in the section about the People Table and related reports. 
 
The report lists all the people in the database who have been classified with the 
“TEACHING” skill.  The Skill Level, Acquired Date and approving supervisor are all 
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optional entries that could be useful.  Skill Levels are defined by the training 
administrator and can be any alphanumeric entry. 
 
Reports Menu - General 
 
The [Reports] Menu is found just under the TrainingRegister® Title Bar as shown in the 
following example.  A [Reports] Tab is found at the top of an entry Form such as the 
entry Form for the People and ClassCatalog Tables (not shown). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The [Reports] Menu contains almost all reports TrainingRegister® has to offer. The 
[Reports] Tabs on various Forms contain copies of some of the reports from the [Reports] 
Menu.  If the “Current Person” is Cindy Adams, only reports about Cindy can be printed 
from the [Reports] Tab and it won’t be necessary to select Cindy since she is already 
displayed on the People Form.  All People related reports can be printed from the 
[Reports] Menu.  If a report on the [Reports] Menu is for a selected person, it will be 
necessary to specify that selected person. 
 
Go Ahead and Experiment with Reports: 
Preparation of reports does not alter data.  Feel free to experiment with the various 
reports.  If a ClassCatalog record is requested, select PAYROLL CODING WORKSHOP 
with ClassID of “99”.  If an individual is requested, select CINDY ADAMS with ID of 
12345.  Both Cindy and the Payroll Coding Workshop have enough data to produce 
demonstrative reports. 
 
Pasting Data In Excel: 
Almost all reports are displayed in the browser.  They can be printed using the browser’s 
print features or emailed as a page using the browser’s mailing feature.  The grid and data 
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displayed in reports can be copied to the Windows Clipboard and then pasted in an empty 
Excel worksheet. 
 
 
TrainingRegister® Messaging Feature 
 
The Messaging Feature is used for sending messages and attachments to most any group 
of people found in the People table including the following: 
 

• Students on an Enrollment Roster 
• People on a Waitlist 
• People who Need a Class/Training 
• People who are Linked to a Training Program 
• One or more individuals based on data or classifications in their People table 

record 
 
The Messaging Feature will be described in greater detail in another Tutorial and in the 
User’s Guide. 
 
Additional Highlights 
 
Recording Historical Training: 
Historical training can be recorded without the need for creating a ClassSchedule Record.  
These data are commonly found on old hard copy sign- in sheets. Speed or shortcut keys 
are provided to accelerate the process. Details are in the User’s Guide. 
 
Importing Employee Data: 
TrainingRegister® comes with a Built- in Import Utility that can be configured to keep 
the People table updated with selected data from an HR or payroll database on a regular 
basis. 
 
Custom Reporting: 
Once TrainingRegister® has been purchased, all data or selected data can be exported for 
use in other systems or for custom report writing. 
 
Custom reports can be created using a third-party report writer and data exported from 
TrainingRegister®.  Data can be exported to an Access table or a comma-delimited file. 
The export feature is disabled in the demo/evaluation version. 
 
TrainingRegister Annual Support Package: 
The purchase of TrainingRegister includes unlimited telephone support for two contact 
people and all updates for a year.  The package can be renewed on a calendar year basis. 
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Multiple Users: 
TrainingRegister® does not limit the number of users.  The TrainingRegister® license is 
for a single database.  In a multi-user environment, the SQL Server version has better 
performance than the Jet version. 
 
Test Before Purchase: 
TrainingRegister® is made available for testing prior to purchase to insure satisfaction 
after the sale.  Please take advantage of this offer and use Technical Support as needed. 
 
Web Module: 
A separate and companion Web Module will permit employees and supervisors limited 
access to the training database.  It can be configured to permit self-enrollment, permit 
supervisors to enroll their own people or not permit self-enrollment.  Employees can see 
their own requirements and training history.  The Web Module does not replace the 
Administration Module. 
 
Contact TrainingRegister Support 
 
This overview did not cover everything that can be done with TrainingRegister®.  If you 
need a feature you did not find, please contact TrainingRegister® Support staff with your 
request.  Please advise if you need additional time for testing. We can easily extend your 
registration without the need to reinstall. 
 
Empty Database: After you have tested TrainingRegister® with the sample data 
provided, you are welcome to test it with a new empty database. Data entered in a fresh 
empty database can be preserved and used with a purchased license.  It can also be easily 
converted to SQL Server format if you decide that is the best route for your organization.   
 
Full Network Installation: If you like what you see and think you are interested in 
purchasing TrainingRegister®, we can help you install everything you might want on 
your network so you can test and share the program with others.  The Administration 
Module can be shared with other training administrators.  The Web Module can be used 
to share with employees and supervisors.  When you are ready to go live, all that will be 
needed is to change the registration information and the database connection. 
 
If you need further assistance or have questions about performing any task please call our 
support staff at 316-942-4339. 
 
 
After completing this Tutorial you should be able to: 
 

• Open Forms for the various Tables using the [Tables] Menu 
• Switch between open forms using the [Windows] Menu 
• Find a person in the People Table using the [Find] button 
• Find a learning experience in the ClassCatalog Table using the [Find] button 
• Find a scheduled class in the ClassSchedule Table using the [Find] button 
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• Prepare reports from the [Reports] Menu that is found just under the 
TrainingRegister® Title Bar 

• Prepare reports from the [Reports] Tabs on the People, ClassCatalog and 
ClassSchedule Forms. 

• List most of what can be done with TrainingRegister®. 
• Confirm TrainingRegister® Technical Support provides great support and can 

answer your questions. 
• Have an idea if TrainingRegister® will be a good fit for your organization. 

 
 
Thanks for testing TrainingRegister® 
 
Sincerely,   TrainingRegister® Support Staff 


